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Lesson 2

Adva nced T a ble D es ign
Les s on Topics
Customizing Field Formats
Captions
Default Values
Input Masks
Validating Field Data
Review Exercise

Les s on Objectives
At the end of the lesson, you will be able to:
Use the Forma t property to change the way in which
numbers, dates, and text values are displayed;
Create custom formats for Number, Currency, and
Date/ Time data types;
Use the Caption property to specify the way in which a
field is identified on a datasheet;
Specify a default value for a field when a new record is
added to a table;
Create an input mask to ensure that data entered into a
field follow a specific pattern;
Use the Input Mask wizard to create an input mask;
Create a validation rule for a field to ensure that only
appropriate values are entered in the field;
Create a custom message if a value does not verify the
validation rule for a field;
Require that a value be entered in a field.

Student Files Us ed
You will use the following file from your student folder:
Properties

Copyright © 1985-2007, Finney Learning Systems, Inc.
All rights reserved.
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Customizing
Field
Formats
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By modifying its properties in Table Design view, you can
customize the way in which a field appears in a datasheet and
form. The available properties depend upon the type of field that is
selected. For example, you can adjust the number of decimal places
that appear for Number data types, or you can adjust the way in
which the date is formatted for Date/Time data types.
Access has many different field properties that can be customized.
You are going to look at some of the most common options.
1.

Open the Properties database file. Remember, all
database files are stored in the FLS Access2003
Student Files folder on the C drive.
Note: If you cannot locate the file, make sure that
you have followed the steps (beginning on page vi)
to install the student files on your computer.
Note: If a security warning alert box like the one on
page 2 appears, click Open.

2.

If necessary, select the Tables tab to display the
table objects.
Notice the different tables in the database. The tables
and fields have been designed using the guidelines
in the previous lesson.

Number and
Currency
Formats

The Format property alters the way in which information appears
in your tables and forms. Number and Currency data types have
the same format properties.
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Double-click the StudentGrades table object to open
it in Datasheet view.
Notice the table datasheet. In particular, notice the
values in the CourseGrade field. As displayed, the
lack of consistency can make these values difficult to
read. You are going to change the format for this
field so that all of the values will be displayed with
two decimal places.

2.

Switch to Design View. (If an Indexes window
appears on top of the Design window, close it.)
By default, the StudentID field is selected (in the top
pane) and its properties are displayed in the Field
Properties pane.

3.

In the top pane, click in the CourseGrade row to
select the field.

4.

Tap the F6 key to switch to the Field Properties pane.

5.

The Field Size options (which you used in the
Beginning Course) affect what type of numbers can be
entered into the field. The Format options affect only
how the numbers are displayed.
Tap the F4 key to display the Format list box.
Notice the predefined formats.
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General Number is the default format. The number is
displayed exactly as entered.
Currency will display the value with a dollar sign ($),
a thousand separator (if needed), and two decimal
places. The number .5 would be displayed as $0.50.
Euro is just like Currency except that the dollar sign
is replaced with the European currency symbol.
Fixed causes the number to be displayed with at
least one digit to the left of the decimal place and
two digits to the right. The number .5 would be
displayed as 0.50.
Standard is similar to Currency, without the dollar
symbol. The number .5 would be displayed as 0.50.
Percent displays the value as a percentage by
multiplying it by 100. By default, two decimal places
are used. The number .5 would be displayed as
50.00%.
Scientific uses standard scientific notation to display
the value. By default, two decimal places are used.
The number .5 would be displayed as 5.00E-01,
meaning 5 " 10 #1.
6.

Choose Fixed.
The values in the CourseGrade field will be displayed
using the Fixed format. By default, each value will
have at least one digit to the left of the decimal and
two digits to the right. You will look at this in a
moment.
Note: The Property Update
Options icon
that appears allows you to
automatically change the field's format in forms and
reports you may have already designed.

7.

You can use the Decimal Places property to change the
number of decimal places that are displayed according
to the Format property.
Click the Decimal Places
drop-down list box.
Notice the options.
You can choose to
display from zero to
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fifteen decimal places. Except for the Auto option,
these settings override the default settings of the
selected Format.
8.

If necessary, select Auto.

9.

Before looking at the changes to the field, you must
save changes to the table design.
On the Table Design toolbar, click the Save
button to save changes to the table design.

10.

Click the Table View button.
Notice the changes to the CourseGrade field.
Once again, only the display of the values has
changed. The original values are stored in the table
just as they were entered.

Note: If necessary, Access will round values. For
example, if you were to set the Decimal Places
property to 1, a grade of 2.67 would be displayed as
2.7. The actual grade, however, would continue to
be stored as 2.67.
11.

Date/Time
Formats

Close the datasheet.

Access allows you to format dates and times in a variety of ways.
You are going to switch tables and look at some of the predefined
date formats.
1.

Double-click the Students table to open it in
Datasheet view.
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Notice the values in the DOE field.

These are the dates on which the students entered
the school. You will change the way in which these
dates are displayed.
2.

Switch to Design View.

3.

In the top pane, select the DOE field.

4.

Tap F6 to switch to the Field Properties pane.

5.

Tap F4 to display the Format drop-down list box.
Notice the available Date/Time formats.

Most of these formats are explained through the
sample date and time that is provided. The default
value is the General Date format, which is a
combination of the Short Date and the Long Time
formats. The General Date format will display only
what was entered. If a time was not entered, only
the date will be displayed. Likewise, if a date was
not entered into the field, only the time will be
displayed.
6.

Choose Medium Date.
Once again, the Property Update Options icon
appears. You can ignore it for now.

7.

Save the changes to the table design.

8.

Switch to Datasheet View.

9.

Increase the width of the DOE column by
double-clicking the right border of the
field header.
Notice the format of the dates.
No matter how the dates were actually
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entered in the table, they are displayed in a medium
date format. A time is not displayed in the field.

Text/Memo
Formats

There are no predefined formats for Text or Memo data types. As
with all formats, however, Access allows you to create your own
custom formats. You are going to set a custom Text format so that
all characters are displayed in uppercase characters. In the next
section you will create some custom formats for Number and
Date/Time data types.
1.

Switch to Design View.

2.

In the top pane, select the LastName field.

3.

Tap the F6 key to switch to the Field Properties
pane.

4.

In the Format box, tap F4 to display the drop-down
list box.
Although a drop-down list box appears, it does not
contain any items. Text data types do not have
predefined formats.

5.

Two common custom format symbols are the less than
symbol (<) and the greater than symbol (>). The first
causes all text to be displayed in lower case letters; the
second causes all text to be displayed in upper case
characters.
In the Format box, type: >

6.

Save changes to the table design and then switch
to Datasheet View.
Notice that the last names are displayed
in upper case characters.

7.

If necessary, you can see how the text was
originally entered.
Click an insertion point in the LastName
field of any record.
Notice that the text is displayed as it
was originally entered.
Note: If you cannot see this, tap the
EDIT key (F2) to enter Edit mode.
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In addition to the predefined formats that are available, you can
create customized formats. You already created a custom format
for the LastName field (using the > character). You are going to
create a custom format for a Number data type and a Date/Time
data type.
1.

The Students table should be open in Datasheet
view.
Notice the contents of the Grade field.
You are going to change the format so that
all numbers are displayed using two digits.

2.

Switch to Design View.

3.

In the top pane, select the Grade field.

4.

Tap F6 to switch to the Field Properties pane.

5.

The zero character (0) is used to specify that a digit
must be displayed. To make sure that two digits are
always displayed, enter a format of 00.
Change the contents of the Format box to: 00

6.

Save changes to the table design and switch to
Datasheet view.
Notice that each grade is now displayed
with two digits. For students in the ninth
grade, a leading zero was added to the
field.
Below are a few other characters that can
be used to create custom formats for
Number data types.

Character
. (period)
, (comma)
0 (zero)
#
$
%

Function
Decimal separator
Thousand separator
Digit placeholder
(displays a digit or zero)
Digit placeholder
(displays a digit or nothing)
Display a dollar symbol
Display the value as a percentage
(with the symbol)
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You can also create custom formats for Date/Time data types. You
are going to create a custom date format so that the DOE field will
be displayed in the format: Wednesday, 8 July 1998. Following are
some of the symbols used to create custom date and time formats:
Symbol
d
dd
ddd
dddd
ddddd
dddddd
w
ww
m
mm
mmm
mmmm

Description
Day of month (1 to 31)
Day of month, 2 digits (01 to 31)
First 3 letters of weekday (Sun to Sat)
Full weekday name
Short Date predefined format
Long Date predefined format
Day of week (1 to 7)
Week of year (1 to 53)
Month of year (1 to 12)
Month of year, 2 digits (01 to 12)
First 3 letters of month (Jan to Dec)
Full month name

1.

Switch to Design View.

2.

You can combine the symbols above with literal text (in
quotation marks), a colon (:) for a time separator, and
a slash (/) for a date separator. Here are some
examples of the formats you can create:

Format
m/d/yy
mm/dd/yyyy
dd mmm yy
d"-"mmm"-"yy
ddd", “ mmmm d”, “ yyyy
mmmm d”, “ yyyy
m/d/yy h:n AM/PM
mm/dd/yy hh:mm AM/PM

Example
7/8/04
07/08/2004
08 Jul 04
8-Jul-04
Wed, July 8, 2004
July 8, 2004
7/8/04 2:35 AM
07/08/04 02:35 AM

Select the DOE field.
3.

Change the contents of the Format box to:
dddd", "d mmmm yyyy

4.

Save the changes to the table design and switch to
Datasheet view.

30

Microsoft Access 2003 - Intermediate

5.

Point to the right border of the DOE field header
and double-click to expand the column.
Notice the custom format for the DOE field.

6.

Save changes to the datasheet.
You have saved the larger column width.

7.

Close the datasheet.
Tip: For more help on custom formats, click in the
Format field property box in Table Design view and
tap the F1 key.

Captions

As you have seen, Access uses the name of a field in the heading
row of a datasheet as well as in the label for a form. By modifying
the Caption property, you can specify a custom label to be used in
these cases. The caption property allows you to create more
descriptive field references without altering the field name (which
could adversely affect other database objects). You are going to
change the DOE caption to Date of Entry.
1.

Open the Students table in Design View.

2.

Select the DOE field and then tap F6 to switch to
the Field Properties pane.

3.

Click an insertion point in the Caption text box and
type: Date of Entry
This caption provides a good description of the field
while still keeping the field name brief.

4.

Save the changes to the table design and then
switch to datasheet view.
Notice the field header at the top of the datasheet.
Although you have not changed the name of the
field, Access will now use
your custom caption as the
default label in datasheets,
queries, and forms.

5.

Close the datasheet.
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It is not uncommon for most records in a table to have the same
value for a particular field. You can use the Field Properties pane to
specify a default value to be entered automatically when a new
record is created. Since all of the students are from New York state,
you are going to use NY as a default value for the State field.
1.

Open the Guardians table in Design View.

2.

In the top pane, select the C1State field.

3.

Tap F6 to switch to the bottom pane and then click
an insertion point in the Default Value box.

4.

Type: NY
From now on, Access will enter NY in the C1State
field automatically when a new record is created.
Once you move the insertion point away from this
field, Access will surround NY with quotations
marks in order to indicate that this exact text should
be used.

Note: The Build button is used to create a default
value that is the result of an expression. You will
work with expressions later.
5.

Save changes to the table design and then switch
to Datasheet view.

6.

Setting a default value for a field does not alter existing
records — only new ones. You are going to start adding
a new record in order to see how the default value
works.
At the bottom of the
datasheet, click the
Add New Record button.
Without actually entering anything in the fields,
notice that the C1State field already contains the
default value of NY. (You may need to scroll to see
this.) By comparison, notice that the C2State field
does not contain any default value.

7.

Tap the UP ARROW key to prevent a new record
from being added to the table.

8.

Close the datasheet.
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A common default value for Date/Time fields is the current date.
You are going to use the current date as a default value for the date
of entry of new students.
1.

Open the Students table in Design View.

2.

Select the DOE field and then tap F6 to switch to
the Field Properties pane.

3.

Click an insertion point in the Default Value field.

4.

Type: =Date()
This is a special function that tells Access to insert
the current date.

5.

Save changes to the table design and then switch
to Datasheet view.

6.

Once again, changes to the Default Value property
affect only new records.
At the bottom of the datasheet, click the Add New
Record button.
In the DOE field, notice that the current date is
entered in the new record automatically. Of course,
you can always change the value.

7.

Input
Masks

Close the datasheet without adding a new record.

You can use an Input Mask to save time as you enter data or to help
ensure that the data in a particular field has a similar appearance in
all records. For example, you can use an input mask to make sure
that all ZIP codes are entered using the ZIP+4 format, with the
hyphen being entered automatically by the mask.
The school has determined that all course identifications consist of
exactly three letters (representing the department) followed by two
or three digits. You are going to use an input mask to make sure
that all courses follow this format.
1.

Open the StudentGrades table in Design View.

2.

Select the CourseID field and then tap the F6 key to
switch panes.

3.

Click an insertion point in the Input Mask box.
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Notice that a Build button appears. You will use this
when you work with the Input Mask wizard.

4.

The Input Mask uses characters to specify a pattern.
These characters are listed below.

Mask
Character
0
9
#
L
?
A
a
&
C
.
,
:;-/
>
<
!
Password

Function
Digit 0 to 9 (required)
Digit 0 to 9 (or space) (optional)
Digit or space (optional)
Letter A to Z (required)
Letter A to Z (optional)
Any letter or digit (required)
Any letter or digit (optional)
Any character or space (required)
Any character or space (optional)
Decimal point
Thousand separator
Date and time separators
All characters to the right
are converted to uppercase
All characters to the right
are converted to lowercase
Fill the mask from right to left
Displays an asterisk for each
character typed

Type: >LLL009
You have told Access that data in this field must be
all uppercase and must consist of exactly three
letters followed by two or three digits.
5.

You are going to test out your Input Mask.
Save the changes to the table and then switch to
Datasheet view.

6.

The mask affects only new records. You are going to
add a course for one of the students.
On the Table Datasheet toolbar, click the
New Record button.
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7.

In the StudentID field, type: 1020

8.

Tap the TAB key to move to the CourseID field.

9.

You are going to try to enter the course MATH200,
which does not follow the Input Mask pattern.
Type (in lowercase): m
Notice that Access
converted the lowercase m to an uppercase M.
In addition, notice the underscore characters
in the field. Access uses these as placeholders.

10.

Type: ath
You are not allowed to type the h. According to the
mask, this fourth character must be a digit.

11.

Type: 200
Since the three digits fit into the mask, the field
accepts them.

12.

Finish adding the new record by entering a
Semester of 961 and a CourseGrade of 3.

13.

Use SHIFT/ENTER to save the record.

An Input Mask will also prevent you from changing existing records
to an incorrect format.
1.

Use CTRL/HOME to go to the first field of the table.
Note: If CTRL/HOME does not take you to the first
field, you are in Edit mode. Tap the EDIT key (F2) to
get out of Edit mode and then try again.

2.

Tap the TAB key to move to the CourseID field.

3.

Tap the EDIT key (F2) to enter Edit mode.
Instead of a thin, blinking insertion
point, notice that the first character is
high- lighted. This indicates that the
field uses an Input Mask.

4.

With the first character highlighted, type: 5
You are not allowed to replace this character with a
digit.

5.

Type: h
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Since the mask allows characters at this position,
Access replaces the E with an H.
6.

Tap the ESC key to undo the changes to the record.

7.

Close the datasheet.

You are going to create an Input Mask for phone numbers.
1.

Open the Guardians table in Design View.

2.

Select the C1PhoneH field and then click an
insertion point in the Input Mask text box.

3.

If you enter a character other than one of the Input
Mask characters, it will appear automatically in the field.
This allows you to have the parentheses and hyphen
appear in the field without being entered.
In the Input Mask field, type: (000) 000-0000

4.

Save the changes to the table design.
Notice that the Input Mask text box now contains
\(000") “000\-0000.

Access uses the backslash character (\) to indicate
that the next character is literal (i.e., should be
displayed). The quotation marks are used to indicate
more than one literal character (in this case, the right
parenthesis and a space).
5.

Switch to Datasheet view so you can test out the
mask.

6.

On the Insert menu, choose New Record.

7.

You are not going to actually enter a new record. You
are simply going to look at the C1PhoneH field.
Tap the TAB key seven times, until the C1PhoneH
field is selected.

8.

Type: 212
Notice that once you type a digit, the
parentheses for the area code
appear, along with the hyphen and
the placeholders for the mask.
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9.

Using a mask allows you to enter any part of the field
in any order.
Tap the RIGHT ARROW key a few times.
Notice that the insertion point moves in the field.
You could enter any part of the field.

10.

Type: 9
The digit is inserted over the active placeholder.

11.

Anything that is entered in this field must match the
Input Mask format. You cannot leave the field partially
entered.
Tap the TAB key to try to move to the next field.
Notice the alert box that appears, indicating that the
value entered does not match the mask.

Input Mask
Wizard

12.

On the alert box, click OK.

13.

Tap the ESC key two times to prevent the record
from being added to the table.

For some of the more common Input Masks — such as those for
phone numbers or social security numbers — Access provides a
wizard to take you through their creation. You are going to use the
Input Mask wizard to create a mask for the C1PhoneW field.
1.

In order to use the Input Mask wizard, the table must
be saved.
Save changes to the Guardians table and switch to
Design view.

2.

Select the C1PhoneW field and then click an
insertion point in the Input Mask text box.

3.

To the right of the text box, click the Build
button.
After a few moments, the first step of the Input
Mask wizard appears.
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Notice the different input masks that are available.
Access provides an example of what the data will
look like with the mask and it provides the Try It
box so that you can test the selected mask with your
own sample data.
4.

In the list box, verify that Phone Number is selected
and then click the Next button.
The second step of the Input Mask Wizard appears.

In the Input Mask text box, notice the format of the
mask that you selected. You can use this dialog box
to change the current format. For example, you
might change the 999 to 000 so that the area code is
required.
The Placeholder character drop-down list box allows
you to choose a placeholder other than the
underscore symbol (_).
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5.

Click the Next button to go to the next step in the
wizard.
The third dialog box appears.

As you have seen, you can use an input mask to
display characters that are not actually entered. This
dialog box gives you the option of storing the data
with these symbols or without these symbols. The
default is to store the data without the symbols,
which means that it takes up less space.
6.

Verify that the second option is selected and then
click the Next button.
The last dialog box in the wizard appears. Access is
prepared to create the input mask.

7.

Click the Finish button.
Notice the input mask.
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If you look closely, you will see that the input mask
has three parts, separated by semicolons (;).
The first part contains the actual input mask — in
this case, !(999) 000-0000.
The second part indicates if the literal characters (i.e.,
hyphens and parentheses) will be stored with the
data. A value of 0 tells Access to store these literal
characters with the data. A blank value or a value of
1 tells Access to store only the characters that are
actually typed.
The third part indicates the placeholder that should
be displayed. You can enter any character here. If it
is blank, the default character (_) will be used.
8.

Save changes to the table design.
As before, notice that Access formats the input mask
with backslash characters (\) and quotation marks.

9.

You will not test out this input mask.
Close the Table Design window.

Notes

The Format property overrides the Input Mask property. For
example, if the format is < (for lowercase) and the input
mask is LL (for uppercase), the text will appear as lowercase.
You can create your own masks to be used with the Input
Mask wizard. On the first dialog box of the wizard, click the
Edit List button. The Customize Input Mask Wizard dialog
box appears, which is basically a form used to display the
existing masks. You can customize the existing masks or you
can click the Add New Record control button to create a new
input mask.

Validating
Field Data

You can add a validation rule to a field in order to have Access
check the data that you enter against a rule that you have specified.
For example, you can add a validation rule so that Access checks
that the Grade field contains only 9, 10, 11, or 12.
You are going to enter validation rules to make sure that only valid
course grades and student identifications are entered.
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1.

Open the StudentGrades table in Design View.

2.

With the StudentID field selected, click an insertion
point in the Validation Rule text box.

3.

The StudentID must be a number between 1000 and
9999. You are going to enter this as a validation rule.
Type: >=1000 and <=9999
The next time you enter a record, Access will check
to see if the StudentID field is between 1000 and 9999
(inclusive).
Note: You can use the same comparison operators
that you used when working with queries. These
include the following: greater than (>), greater than
or equal to (>=), less than (<), less than or equal to
(<=), equal to (=), not equal to (<>). These operators
can be combined with the AND or the OR logical
operators.
Tip: By using the Build button in the Validation Rule
box, you can enter functions as validation rules.

4.

If the data does not satisfy the validation rule, an alert
box will appear. You can use the Validation Text text
box to customize the message that appears.
Click an insertion point in the Validation Text text
box.

5.

Type: The StudentID must be between 1000 and 9999.

6.

To make sure that data is entered in a field, you can set
the Required item to Yes.
Tap the TAB key to move to the Required text box.

7.

Click the drop-down list box and choose Yes.

8.

You are going to set a validation rule for the
CourseGrade field.
In the top pane, select the CourseGrade field.

9.
10.

Click an insertion point in the Validation Rule text
box.
You can use the IN operator to have Access validate the
data against a list. When using a grade scale from 0 to
4, grades increment by one third.
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Type: In(0, 0.33, 0.67, 1, 1.33, 1.67, 2, 2.33, 2.67, 3,
3.33, 3.67, 4)
These are the only valid grades. Instead of using the
IN operator, you could have used the OR operator
between each valid grade.
Tip: To make it easier to enter long validation rules,
use SHIFT/F2 to display the Zoom window, or click
the Build button to open the Expression Builder
dialog box.
11.

Click an insertion point in the Validation Text text
box and type: This is not a valid grade. Make sure you
are using a grading scale from 0 to 4.

12.

Use the Required drop-down list box to make this a
required field.

13.

Unlike many of the other field properties, validation
rules affect existing records. When you try to save
changes to a table for which you have changed the
validation rules, Access will alert you to this.
On the File menu, choose Save.
An alert box appears indicating that data integrity
rules have changed.

14.

Click Yes to have Access check existing records
against the validation rules you entered.
After a few moments, Access finishes checking the
existing records. If another alert box appears, you
might have made an error entering the validation
rules. Click Cancel, check both of the validation
rules that you created, and then try again.
Tip: You can also check the validation rules by
choosing Test Validation Rules on the Edit menu.

15.

Switch to Datasheet view.

You are going to test out the validation rules.
1.

On the Insert menu, choose New Record.
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2.

In the StudentID field, type: 4

3.

Tap the TAB key to move to the next field.
Since the StudentID does not meet the validation
criteria, an alert box appears with the custom
validation text.

4.

On the alert box, click OK.

5.

Change the contents of the StudentID field to 1000
and then tap the TAB key.
Since this is a valid StudentID, you are permitted to
move to the next field.

6.

Enter a CourseID of: ELE105

7.

Tap the TAB key and enter a Semester of: 961

8.

Tap the TAB key and enter a CourseGrade of: 1.5

9.

Use SHIFT/ENTER to save the record.
Since the grade that you entered does not verify the
validation rule, an alert box appears with the
validation text that you created.

10.

Click OK to close the alert box.

11.

Change the CourseGrade to 2 and then use
SHIFT/ENTER to save the record.

12.

Close the datasheet.
Note: Text and Memo data types have another
option — the Allow Zero Length property. Normally,
if you do not enter data in a Text or Memo field,
Access stores a Null value in the field. The Null
value is used to indicate missing or unknown data
(such as a work phone number). On the other hand,
a zero length string (which consists of two quotation
marks with no space between them) is used to
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indicate data that does not exist (such as a work
phone number if the guardian stays at home).

Review
Exercise

To review the concepts presented in this lesson, you are going to
change the design of the Attendance table to include format options,
default values, input masks, and validation rules.
1.

Open the Attendance table in Design View.

2.

First, you are going to modify the StudentID field.
The StudentID field should be exactly four digits
long. Create an input mask to indicate this.

3.

Enter a validation rule so that Access checks that
the StudentID is between 1000 and 9999. Include an
appropriate validation text.

4.

Indicate that the StudentID is a required field.

5.

Next, you are going to modify the Date field.
Set the Format property for the Date field to Short
Date.

6.

Use the Date() function to set the current date as
the default value for the field.

7.

Make the field a required field.

8.

Finally, you will modify the Attendance field.
Format the contents of the Attendance field so that
all characters are uppercase.

9.

Indicate a caption of Absent/Late.

10.

Indicate that the default value for this field is
Absent.

11.

Use the Validation Rule to verify that only a value of
Absent or Late is allowed in this field. Create an
appropriate Validation Text to indicate this.

12.

Make the Attendance field a required field.

13.

Save changes to the table design, using the alert
box to have Access verify the existing records.

14.

Switch to Datasheet view.
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Notice the format of the table datasheet.

15.

Test out the new field properties by adding a few
new records to the table. Be sure to enter values
that will not pass the validation rules.

End of Lesson 2

